
Informatik Image Markup 
 
 

Version 7.20 

 
 
 
 
 
 
 
 
 
 

User Guide 
 
 
 
 
 
 

April 2, 2009 
 

Please visit www.informatik.com for the latest version of the software. 

 

 



Table of Contents 

 

General .................................................................................................................3 
Open an Image File ..............................................................................................3 
Lines .....................................................................................................................4 
Arrows...................................................................................................................4 
Freehand Drawing ................................................................................................4 
Highlighting ...........................................................................................................4 
Path (Irregular Shapes).........................................................................................4 
Redaction (White-out, Black-out) ..........................................................................5 
Rectangles (Boxes)...............................................................................................5 
Ellipses .................................................................................................................5 
Bullets ...................................................................................................................6 
Insert Text (General).............................................................................................6 
Insert Curved or Rotated Text...............................................................................7 
Insert Watermark ..................................................................................................8 
Insert Image (Files or Clipboard)...........................................................................8 
Insert Rubberstamps.............................................................................................9 
Insert Text Balloon ................................................................................................9 
Copy to Clipboard .................................................................................................9 
Crop Image ...........................................................................................................9 
Rotation ..............................................................................................................10 
Transparency......................................................................................................10 
Layers .................................................................................................................10 
Delete an Object .................................................................................................11 
Commit Change..................................................................................................11 
Save the Changes ..............................................................................................11 
Print ....................................................................................................................12 
Licensing Information..........................................................................................12 
Technical Support ...............................................................................................12 
License, Warranty, Disclaimer ............................................................................12 
Copyright and Trademarks..................................................................................14 



GeneralGeneralGeneralGeneral    
 

The program requires Microsoft .NET Framework version 2.0 or later. 
 
The program supports TIFF, BMP, PNG, GIF and JPEG graphics formats.   
 
For marking up PDF filesPDF filesPDF filesPDF files, please use the Informatik PDF Markup program.  
 
Please visit the publisher’s website often and find out if upgrades and newer 
versions are available.   www.informatik.com 
 
Always back up your files before they may be overwritten. 
 
 
 

Open Open Open Open an Imagean Imagean Imagean Image File File File File    
 
Files can be opened from either the File menu or the toolbar.  If the file is a multi-
page file (TIFF), navigate thru the pages with the navigation buttons in the 
toolbar: First Page, Previous Page, Next Page, Last Page, Prompt for Page. 
 
Informatik Image Markup has the following edit functions: 
 

• Lines 

• Arrows 

• Freehand drawing 

• Highlighting 

• Irregular shapes (Path) 

• Redaction (white or black) 

• Rectangles (Boxes) 

• Ellipses 

• Bullets 

• Insert Text (general) 

• Insert Text (curved, rotated) 

• Insert Watermarks 

• Insert Graphics 

• Insert Rubber Stamps 

• Insert Text Balloon 

• Insert Curved or Rotated Text 

• Crop 
 
 
When you select a drawing option, most stay in effect until you select another 
option.  To cancel the option, click on the Pointer icon or press the ESC key. 
 



 

LinesLinesLinesLines    
 
Click on the Line button.  Review and change the line thickness and drawing 
color.  With your left mouse button pressed draw the line.  If needed, move the 
object and set transparency. 
 
 

ArrowsArrowsArrowsArrows    
 
Click on the Arrow button.  Review and change the line thickness and drawing 
color.  With your left mouse button pressed draw the outline of the arrow.  If 
needed, move the object and set transparency. 
 
A terminal arrow can also be added in the Path (Irregular Shapes) option. 
. 
 

Freehand DrawingFreehand DrawingFreehand DrawingFreehand Drawing    
 
Click on Freehand.  Review and change the line thickness and drawing color.  
With your left mouse button pressed draw your pattern.  The initial line will be a 
black draft.  When you release the mouse button, the colored drawing will be 
displayed.  If needed, move the object and set transparency. 
 
 

HighlightingHighlightingHighlightingHighlighting    
 
Click on the Highlight button.   Review and change the current Highlight color 
setting.  With your left mouse button pressed outline the rectangle of the area that 
you wish to highlight.  Release the mouse button.  If needed, move the object.  
 
The Highlight option ‘highlights’ text on white background.  The default color is 
yellow but the color can be changed in the Highlight Color pallet.   
 
 

Path (Path (Path (Path (Irregular Irregular Irregular Irregular SSSShapeshapeshapeshapes))))    
 
This option represents a series of lines that represent a path (open or closed).   
Click on the Path button.  Review and change the line thickness and drawing 
color.  If the path will lead to a closed shape you can opt to have the area color 
filled.  Review the current Fill Color setting.   
 
With your left mouse button click on the corners of the outline.  To close the path, 
click on the small circle at the start point of the first line.  To leave the path open, 
when done, click on the ‘Check’ icon button (next to the Path button).  To cancel 



the drawing, click on the Cancel icon button (next to the Path button).  If the lines 
should be exactly horizontal or vertical, then draw the lines while holding down 
the SHIFT key.   
 
A closed path can be color-filled or filled with a hatch pattern.  If you check the 
Hatch FillHatch FillHatch FillHatch Fill checkbox, the Hatch Pattern window opens where you can select from 
one of five hatch patterns:  cross, horizontal, vertical upward diagonal and 
downward diagonal.  The hatch color is always black but the background will be 
the selected Fill ColorFill ColorFill ColorFill Color (if the Color Fill checkbox is checked).   If you wish to 
hatch-fill an existing shape, mark the inside area with the Path option; you will 
want to un-check the Draw Border in the Hatch Selection window. 
 
You can add an arrow to the last section line.  Before you draw the path, check 
the ‘Add ArrowAdd ArrowAdd ArrowAdd Arrow’ checkbox.  The option is ignored if either the Fill-Color or Hatch-
Fill is checked. 
 
If needed, move the object and set transparency. 
 
 

RedactionRedactionRedactionRedaction (White (White (White (White----outoutoutout, Black, Black, Black, Black----out)out)out)out)    
 
Click on the Redaction button.   Select White or Black setting..  With your left 
mouse button pressed outline the redaction area.  Release the mouse button.  If 
needed, move the object.   
 
 

Rectangles (Boxes) Rectangles (Boxes) Rectangles (Boxes) Rectangles (Boxes)     
 
Click on the Rectangle button.   Review and change the current Drawing color 
setting.  If the rectangle needs to be color-filled, check the Fill checkbox and 
review/select the Fill color.  You have an option to render the shape square or 
with rounded corners.  With your left mouse button pressed outline the rectangle. 
Release the mouse button.  If needed, move the object and set transparency. 
 
 

EllipsesEllipsesEllipsesEllipses    
 
Click on the Ellipse button.   Review and change the current Drawing color 
setting.  If the ellipse needs to be color-filled, check the Fill checkbox and 
review/select the Fill color.  With your left mouse button pressed outline the 
ellipse. Release the mouse button.  If needed, move the object and set 
transparency. 
 
 



BulletsBulletsBulletsBullets    
 
Click on the Bullet button. Review and change the current Drawing color setting.  
If the bullet needs to be color-filled, check the Fill checkbox (the bullet will then be 
filled with the drawing color).  Click on the spot where you like to insert the bullet.  
If needed, move the object. 
 
 

Insert TextInsert TextInsert TextInsert Text (General) (General) (General) (General)    
 
Click on the Text button.  The Insert Text window opens.  Type the text and set 
the many properties, such as font size, color, style, background color, etc. and 
click on the OK button.  The object will appear in the upper left corner of the 
display window.  Move the object to the desired location.  If needed, rotate the 
object. 
 
For special ASCII characters (characters that are not on the keyboard), click on 
Special Characters button, select and insert the character. 
 
 
 



Insert Insert Insert Insert Curved or Rotated TextCurved or Rotated TextCurved or Rotated TextCurved or Rotated Text    
 
Click on the Curved Text button.  The Curved Text window opens.  Type the text 
and set the font, font size and text color.  Select an option from the dropdown list: 
 
Complex CurveComplex CurveComplex CurveComplex Curve:  Two-sided, s-shaped curve (Bezier curve) 
SymSymSymSymmmmmetric Curveetric Curveetric Curveetric Curve:   Symmetrical curve. 
RotataRotataRotataRotatable straight Lineble straight Lineble straight Lineble straight Line    
 
The background of the image will appear faintly thru the window so that you can 
line up the text.  The transparency is quite faint.  You can increase the 
transparency by checking the ‘Increase Transparency’ checkbox. 
 
 
Complex Curve 
 
Select ‘Complex Curve’ from the dropdown list.  The green icon represents the 
starting point of the text string; the red icon represents the end point.  Move the 
green and/or red icons to set the general orientation of the text curve.  The two 
square handles define the tangent of the curve, at both ends of the text, either 
above or below the text line.  Move any of the handles and icons until you get the 
correct shape.     
 
To center the text along the curve, click on the ‘Leading Space’ button, until the 
text is correctly centered.  
 
 
Symmetric Curve 
 
Select ‘Symmetric Curve’ from the dropdown list.  The green icon represents the 
starting point of the text string; the red icon represents the end point.  Move the 
green and/or red icons to set the general orientation of the text curve.  The 
square handle defines the tangent of the curve; it can be placed above or below 
the text line.  Move the handles and icons until you get the correct shape.     
 
To center the text along the curve, click on the ‘Leading Space’ button, until the 
text is correctly centered.  
 
 
Rotated Text 
 
For Rotated Text, select ‘Rotated Text’ from the dropdown list.  Move the green 
or red icon until you get the correct angle.  The green icon represents the starting 
point of the text string; the red icon represents the end point.   
 
When done, click on the OK button.  If necessary, move the object to the correct 
location. 



 
 

Insert WatermarkInsert WatermarkInsert WatermarkInsert Watermark    
 
Click on the Watermark button.  The Insert Watermark window opens.  Select or 
type the text of the watermark and select the properties.  Select the orientation of 
the watermark (diagonal, horizontal, vertical).  There are two fixed letters sizes.  
Choose the “Large’ option for the larger option.  The watermark is rendered at a 
defaulted 60 percent transparency.    The watermark can be a transparent gray or 
it can be in the form of outline letters (hollow letters).  The angle if the watermark 
text can be horizontal, vertical or diagonal.   
 
Click on the OK button, then drag the watermark object to the desired location.   
 
The initial drop-down list of default watermark words is not extensive and you will 
want to add your own text items to the list.  This can be done in the Setup (via the 
File menu).  In Setup, simply enter the watermark text strings, separated by a 
semi-column.  While in Setup, you can also change the transparency factor which 
is initially set at 60. 
 
 

Insert Insert Insert Insert ImageImageImageImage (Files or Clipboard) (Files or Clipboard) (Files or Clipboard) (Files or Clipboard)    
 
Click on the Image button.  The Insert Graphics window opens.  Specify the 
image file name or click the Clipboard checkbox and select the properties.  Click 
on the OK button.  The object will appear in the upper left corner of the display 
window.  Move the object to the desired location.  If needed, rotate the object and 
set transparency. 
 
The following image formats can be imported:  BMP, PNG, GIF, TIFF, JPEG.   
 
When you clip and copy a section of the image to the clipboard, the clipboard 
image will have a PPI of 96x96 (this is a Windows feature).   So, if you paste the 
image back, you may need to re-size it as it may appear too large.  Resizing of 
pasted images should be done in the Insert Image window. 
 
If the color depth of the inserted image is larger than the color depth of the page 
image (for example a True Color (24-bit) image inserted onto a monochrome 
page), the file size of the saved page can increase dramatically.  To keep the file 
size at a reasonable level, True Color inserts can be rendered as 256 Color (8-bit 
images).  Your eyes are unlikely to see the difference in quality.  To reduce the 
True Color insert images to 256-Color images check the ‘Optimized to 8-Bit 
Color’ checkbox.  
 
Set the ‘Make White Transparent’ if you like to insert a monochrome image and 
make the background transparent, for example when inserting a signature image. 



 
 
 

Insert RubberInsert RubberInsert RubberInsert Rubberstampsstampsstampsstamps    
 
Click on the Stamp button.  The Insert Stamp window opens.  Select or type the 
text of the stamp and select the properties.  The stamp is rendered in dark blue.    
Click on the OK button.  The object will appear in the upper left corner of the 
display window.  Move the object to the desired location.  If needed, rotate the 
object. 
 
You may want to tilt the stamp a bit to give it more realism (use the Rotation 
option).   
 
The initial drop-down list of stamp words is not extensive and you will want to add 
your own text items to the list.  This can be done in the Setup (via the File menu).  
In Setup, simply enter the stamp text strings, separated by a semi-column.   
 
 

Insert Text BalloonInsert Text BalloonInsert Text BalloonInsert Text Balloon    
 
Click on the Balloon button.  The Insert Balloon window opens.  Type the text and 
choose the direction of the balloon pointer.  Set the many properties, such as font 
size, color, style, background color, etc. and click on the OK button.  The object 
will appear in the upper left corner of the display window.  Move the object to the 
desired location.   
 
 

Copy to ClipboardCopy to ClipboardCopy to ClipboardCopy to Clipboard    
 
A selected section of the image can be copied to the Windows Clipboard.  With 
your mouse, select a rectangle section and click on the Copy button.  The 
rectangle area is copied to the Clipboard.  To retrieve the clipped section from the 
Clipboard, click on the Image button (check the Paste from Clipboard checkbox). 
 
 
 

Crop ImageCrop ImageCrop ImageCrop Image    
 
A selected section of the image can be cropped.  With your mouse, select a 
rectangle section and click on the Copy button.  The cropped image replaces the 
image currently displayed.  To undo the cropping action, use the Restore option 
in the file menu. 
 



If you like to crop an area but wish to preserve the original size (on white 
background) use the following four-step procedure: 
 

a) With the Copy function (not Crop function), copy the selected image area 
to the Windows Clipboard. 

b) White out the entire area of the image with the white Redaction option. 
c) Click on the Commit Change button. 
d) With the Image option, insert the Clipboard object.  

 
 

RotationRotationRotationRotation    
 
The Rotation option allows you to rotate some inserted objects to any angle 
(inserted images text objects only).  Select the object and click on the Rotate 
button and select from 90 or 180 degrees clockwise or counter-clockwise, or 
enter your own angle.  The selected rotation is applied to the original orientation 
(not incremental). 
 
 

TransparencyTransparencyTransparencyTransparency    
 
After you have drawn the objects you can change their transparency.  The 
transparency function is available only for drawn lines and shapes.  Watermarks 
are already rendered at 60 percent transparency and you can change the 
transparency factor in Setup.  Select the object and click on the Transparency 
button.  Available transparency values are 0 to 90, where 0 is totally opaque and 
90 is almost totally transparent.  The selected transparency is applied to the 
opaque state (not incremental).   
 
Note:  The current version of the PDF display window may renders certain 
transparent objects as opaque.    
 
 

LayersLayersLayersLayers    
 
When you select an object it will bring it to the foreground.  To send it to the 
background (behind other objects), click on the ‘Send to Back’ button.   
 
Objects placed behind an opaque item will become invisible.  To bring the hidden 
object to the foreground, do the following: 
 

• Click on the window background so that no object has the focus. 

• While no object has the focus (no object is activated), click on the spot 
where you believe the hidden item might be located.  If you hit the correct 
spot, the hidden object will be brought to the foreground and will get the 
focus. 



• If the hidden object does not appear, repeat the process but first again 
click on the window background so that no object has the focus. 

• Or, simply move the covering object and unveil the objects behind it. 
 
 

Delete an ObjectDelete an ObjectDelete an ObjectDelete an Object    
 
Objects can be deleted in one of the following ways: 
 

a) Select the object and click on the Delete button. 
b) Select the object, right-click and choose the Delete option. 
c) Select the object and press the Delete button on the keyboard. 

 
 

Commit ChangeCommit ChangeCommit ChangeCommit Change    
 
When you click on the Commit Change button, the edit changes you made thus 
far are saved to a temporary file (not to the final file).  This option is useful only if 
you have a lot of changes and you wish to commit the changes before continuing.  
You can restore to the original image with the Restore option in the File menu. 
 
For multipage files, the changes are committed automatically when you move to 
another page; there is no need to press the Commit Change button in this case. 
 
 

Save the ChangesSave the ChangesSave the ChangesSave the Changes    
 
When the editing is completed, you must save the file.  The save option is 
available from the File menu or the toolbar.  Always save the edited file to a new 
name so that you have an opportunity to restore to the original file 
 
For cautionary reasons, to avoid overwriting good files, the edited files must be 
saved to a filename other than the source file name. 
 
An option to save only the current page of a multipage PDF files is available in 
the File menu. 
 
If you need to restore a page use the Restore Current Page option in the File 
menu. 
 
The licensed version allows you to save the file in PDF formatPDF formatPDF formatPDF format.   
 
Color images generally create files of a large byte size.  You can reduce the file 
size by converting color images to monochrome.  The monochromemonochromemonochromemonochrome conversion 
option can be found in the Edit menu. 
 



 
 

PrintPrintPrintPrint    
 
The current page with the editing changes can be printed.  This option may be 
useful, for example, if you like to print a document with redactions, without 
actually changing and saving the document.  The Print option can be found in the 
file menu. 
 
 

Licensing InformationLicensing InformationLicensing InformationLicensing Information    
 
Please visit www.informatik.com.    
 
 

Technical SupportTechnical SupportTechnical SupportTechnical Support    
 
Supplied without any liabilities or warranties. 
Please visit www.informatik.com for contact information. 
 
 

License, Warranty, Disclaimer License, Warranty, Disclaimer License, Warranty, Disclaimer License, Warranty, Disclaimer     
 
Please read the terms carefully before installing and using the software, as such 
conduct will indicate your acceptance of all of the terms of this license 
agreement.  If you do not agree with the terms, the software cannot be licensed 
to you and you must un-install and return the software to Informatik Inc, or its 
supplier or distributor. 
 
This License Agreement is a legal agreement between Informatik Inc. 
("Licensor"), a Delaware Corporation, and you, the user ("Licensee"), and is 
effective the date Licensee installs the software. 
 
This Agreement covers all materials associated with this software (all modules), 
including, without limitation, the downloadable software product, online 
documentation, and any additional supporting electronic files (herein, the 
"Software"). 
 
The evaluation version may be used for 30 days after installation.  It is unlawful to 
use the software after the 30 day evaluation period without licensing the software 
and paying the license fees.  If a license is not obtained before the expiration of 
the 30 day evaluation period, the Software must be un-installed and destroyed. 
 
1. GRANT OF LICENSE 



Licensor hereby grants to you, and you accept, a nonexclusive license to use the 
Software according to the following condition: 
 
You may use the Software on one (1) computer (PC or workstation, excluding 
servers) owned, leased, or otherwise controlled by you for personal or business 
purposes, and only as authorized in this License Agreement.  The Software may 
not be used on other computers, nor may it be used by, or transferred to, other 
computers over a network.   
 
2. LICENSOR'S RIGHTS 
Licensee acknowledges and agrees that the Software is proprietary to Licensor 
and protected under international copyright law. Licensee further acknowledges 
and agrees that all right, title, and interests in and to the Software, including 
associated intellectual property rights, are and shall remain with Licensor. The 
License Agreement does not convey to Licensee an interest in or to the Software, 
but only a limited right of use that may be revoked in accordance with the terms 
of this License Agreement. 
 
3. OTHER RESTRICTIONS 
This License Agreement strictly forbids distribution of the Software with 
Licensee's application. Distribution of the Software with Licensee's application 
requires separate authorization and the payment of license fees. 
  
Licensee agrees to make no more than one (1) back-up copy of the Software. 
Licensee agrees not to assign, sublicense, transfer, pledge, lease, rent, or share 
the rights assigned under this License Agreement. Licensee agrees not to 
reverse assemble, reverse compile, or otherwise translate the Software. 
 
4. TERM 
This License Agreement is effective when Licensee installs the Software and 
shall terminate only if the terms of this License Agreement are broken. Licensee 
agrees to destroy the Software upon termination of this License Agreement. 
 
5. NO WARRANTY; LIMITATION OF LIABILITY 
LICENSEE ACKNOWLEDGES THAT THE PROGRAM IS PROVIDED ON AN 
"AS IS" BASIS WITHOUT WARRANTY OF ANY KIND. LICENSOR MAKES NO 
REPRESENTATIONS OR WARRANTIES REGARDING THE USE OR 
PERFORMANCE OF THE SOFTWARE. LICENSOR incl. DEVELOPER, 
COPYRIGHTHOLDER, DISTRIBUTOR) EXPRESSLY DISCLAIMS THE 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. LICENSOR SHALL HAVE NO LIABILITY TO LICENSEE OR ANY 
THIRD PARTY FOR ANY LOSS OR DAMAGE CAUSED, DIRECTLY  
OR INDIRECTLY, BY THE SOFTWARE, INCLUDING, BUT NOT LIMITED TO, 
ANY INTERRUPTION OF SERVICES, LOSS OF BUSINESS, LOSS OF DATA 
OR SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES.  LICENSOR IS 
NOT RESPONSIBLE FOR THIRD PARTY SOFTWARE INCLUDED IN AND 
USED BY THE SOFTWARE 



 
6. GOVERNING LAW 
This License Agreement shall be construed and governed in accordance with the 
laws of Pennsylvania.  
 
7. SEVERABILITY 
Should any court of competent jurisdiction declare any term of this License 
Agreement void or unenforceable, such declaration will have no effect on the 
remaining terms hereof. 
 
8. NO WAIVER 
The failure of either party to enforce any rights granted hereunder or to take 
action against the other party in the event of any breach hereunder shall not be 
deemed a waiver by that party as to subsequent enforcement of rights or 
subsequent actions in the event of future breaches. 
 
 

Copyright and Trademarks 
 
Copyright 2006-2009 Informatik Inc and J Buchmann.  All Rights Reserved. 
‘Infothek’ is a Registered Trademark of Informatik Inc. 
 
Microsoft and Windows are registered trademarks of Microsoft Corporation. 

 


